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EXPRESSION MEDIA 

EXPRESSION MEDIA 2.0 / IVIEW MEDIA PRO  

 

Expression Media / iView MediaPro 

http://www.microsoft.com/prophoto/expressionmedia2/default.aspx 

Additional Information about the previous version available at:  

http://www.iview-multimedia.com/  

 

 

 

http://www.microsoft.com/prophoto/expressionmedia2/default.aspx
http://www.iview-multimedia.com/
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Microsoft Expression Media is an image-cataloging tool with powerful metadata features.  

Unlike many other applications for editing and viewing photo metadata, Expression Media, (formerly iView Media 

Pro) requires no set up - other than specifying the size of thumbnails. It’s a Swiss Army knife for the digital 

photographer, a truly multi-faceted digital image application.  

It does an excellent job of reading the metadata in a wide variety of image file formats. It boasts both quick-find 

and advanced-search options. You can even create and distribute a self-running version of any catalog on CD, 

create custom web galleries, print contact sheets and turn a sequence of images into a QuickTime Movie.  

Expression Media can import a smorgasbord of file types - too many to list. It can read legacy IPTC (IPTC-IIM) 

and IPTC Core (XMP) metadata in TIFF, JPEG, PSD, DNG, as well as the proprietary Nikon NEF and Canon 

CR2 Raw file formats. And it can write metadata to a similarly long list. 

Expression Media (and iView 3.13) can read XMP data in Adobe DNG files. It writes XMP metadata - including 

IPTC Core and Expression Media-specific fields, such as its proprietary Catalog Sets. Expression Media catalogs 

can even store custom metadata and write them to the original files (that support embedded metadata) in XMP 

format.   

In addition to writing metadata, Expression Media enables quick viewing of "media" (images and more). A Light 

Table feature includes a Magnifier to check for sharpness, as well as a histogram and warning feature to highlight 

parts of an image that are over- or underexposed.  

SETUP  

 

When you ingest or import an image into Expression Media, it creates a thumbnail for reference, notes the image 

location (file path) and reads any existing metadata - in the image file or in an XMP sidecar file.  

You have three options for viewing field name labels in the program's Info panel: IPTC Core, Microsoft Expression 

Media and Adobe Photoshop CS. Choose one in Preferences, under the Edit menu for Windows, or the 

Expression Media (iView Media Pro) menu for Mac. We recommend use of the IPTC Core settings. This option 

emphasizes the field names preferred by the IPTC, which are not specific to any particular product and should be 

most familiar to those using newer applications. 

 
The Mac version of Expression Media shows three options for Photo Metadata Field names. 
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The main Preference panel in Expression Media for Windows. 

IMPORTING IMAGES 

  

To bring images into Expression Media use the Import Items option under the File menu and choose the From 

Files/Folders (shortcut Command/Ctrl+I), or simply drag and drop a folder of images on the Expression Media 

window. With Import Items, you can directly access options – such as file size or modification date - to limit which 

files you import. In the same sub-menu, you’ll see an option to import another Expression Media or iView Media 

Pro catalog file. You can also import images directly from a camera, a memory card or even a specific Internet 

URL (address).  

 

Use the Import Items menu to import images from Files/Folders, cameras and more. 
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If you drag and drop a folder, or individual files into the open catalog window, Expression Media ignores any of 

these previous settings. So if you want to limit which files you import, use the menu options in Expression Media.  

ENTERING METADATA 

 

Once you've imported images and saved a catalog (Save under the File menu), you are ready to enter 

information. But understand any new information you enter in Expression Media only exists within the image 

catalog at first. At any time, you can synchronize - or save to the image file - that information with the Sync 

Annotations option under the Action menu.  

To enter metadata, first single-click on its thumbnail or file name. Be sure the Info panel is open, which may 

require toggling away from the Organize panel view or clicking on the Info Panel button in the tool bar.  

 

The Info Panel view shows the various metadata fields for an image. 

With Expression Media, you can add metadata to a single image or to multiple files at the same time. To choose a 

single image, click on it. To select a range, click on the first image, hold down the shift key and click on the last 

image in the range. You can also select non-contiguous images by pressing Command (Mac) or Ctrl (Windows) 

key while clicking on selected images.  

To change the fields visible in the Info panel view, use the Show/Hide Fields option accessed from the icon 

beside the check mark, below the Organize Panel button. 
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The Show/Hide Fields dialogue is under the icon shown in this view from Expression Media for Mac.  

After clicking on that icon, you will see a pop-up menu, from which you can select the Show/Hide Fields option. 

Choosing this brings up a floating dialogue with check boxes that control which metadata fields display in the Info 

Panel. Use the triangles on the left to expand or collapse the sections. You may wish to uncheck options for 

movie tracks or cue points if you work only with still images.   

 

ADDING METADATA  

 

To add metadata to most fields, simply double-click on the boxes beside the field names and enter information. If 

you routinely type the same information in the same field, check for pull-down menu of past values. Many of the 

fields, such as City, State, Country and Keywords, have this feature. 

For details on what information belongs in each field, see the Guide to Photometadata Fields [link to 4.3] or 

download the IPTC User's guide. 

If you intend to fill in most fields, do not press the enter or return key after typing an entry. To go to the next 

field, press the tab key after entering your information. Holding down the shift key and pressing tab, will take you 

to the previous field. 

Once you have several values in the pull-down menus, a choice of possible entries appears as you type the first 

letter in a field. Using the the tab key to advance, you may find you can enter a lot of information without ever 

lifting your fingers from the keyboard. (Note: If you do press the enter or return key and then press tab, you will 

cycle from the main Info Panel, to the Description field, to selected images, then to the Search box before 

returning to the Info panel. We suggest you just use the tab key.) 

http://www.iptc.org/std/Iptc4xmpCore/1.0/documentation/Iptc4xmpCore_1.0-doc-CpanelsUserGuide_13.pdf
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Also note there are a few fields, such as Keywords and Categories, that can hold more than a single entry. 

Pressing the tab key after typing in these fields will create an additional entry for that field, rather than taking you 

to the next field. You will need to move and click with your mouse to the next field. 

To save to the Expression Media database your changes to the data fields, you can either click on the check 

mark button in the upper right corner of the Info panel or click on another, unselected image.  

 

To confirm the addition of any or all metadata entries for an image in an Expression Media image catalog, click on the check 

mark in the Info window or click to an unselected image. 

If you make a mistake, you can remove entries by selecting them and pressing the delete key. A line will appear 

through the entry, and the green slash beside the field will light up. When you press the green check mark or click 

to another image, that field will clear. At some point you will probably want to get this information back into the 

original file, so note that for now, the information is only in the Expression Media database. 

Access the Contact Info fields with the tiny icon to the right of the Creator field (if using the IPTC Core fields). If 

you have the Adobe Photoshop CS or Expression Media field names in use, look for this next to the Author field 

instead. Clicking this icon will reveal a new dialogue in which you can input your address, phone, email and Web 

site information. 

 
The Contact Info dialogue in the Windows version of Expression Media shows how to access existing sets of contact info. 
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You can rate your images using stars or give them a color label. The star ratings are stored in XMP, and will show 

up in Adobe Bridge, Lightroom, Photo Mechanic and other applications that use XMP. The color labels in 

Expression Media, however, are stored using a unique method and are not widely compatible, so if you want your 

ratings to appear in other applications, you may want to stick with the stars. 

Again, please understand all of these entries, whether text values or star ratings, are only stored in your 

Expression Media or iView MediaPro catalog at this point in your workflow. In order to embed the edited metadata 

in your image file, so it can be viewed outside your catalog, you must "synchronize" the information to the 

original file. 

Choose Sync Annotations from the Action menu, and select Export annotations to original files from the 

resulting dialogue. You can also use the keyboard shortcut Ctrl+Alt+B (Windows) or Option+Command+B (Mac) 

to access that dialogue. 

  

Use the Sync Annotations button under the Action Menu to write metadata to the original file(s).  

 
 

From the resulting dialogue, you can choose which additional information to include when you synchronize your metadata. 
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You can choose from several options when synchronizing. You can include GPS information, hierarchical 

keywords, catalog sets and any custom fields you have created. Leaving all these export options checked will 

ensure all such information is stored in the original image file. If that information is not present in the database, 

nothing will be added, so it does no harm to leave them checked. 

If you have modified image metadata with other software tools, you can use Sync Annotations to update 

information in the Expression Media database by pulling it from the modified files. Import options allow you to 

replace the existing information or merge it, with a choice of whether the information already in the file - or that 

previously entered in the Expression Media database - takes precedence. 

Of course, the image file format must also support synchronizing of metadata for this feature to work. Expression 

Media writes both IPTC-IIM (using the Image Resource Block) and IPTC Core (using XMP) directly into JPEG, 

JPEG2000, TIFF, Photoshop (PSD) and DNG files. It can also write legacy IPTC-IIM metadata to Nikon NEF and 

Canon CR2 Raw files. Second, the file must be in a location where you can write or resave the file. If, for 

instance, you cataloged a CD or DVD, you will not be able to synchronize the metadata added to the Expression 

Media database with the original file, since it's on "read-only" media.  

USING METADATA TEMPLATES  

 

If you routinely enter the same information into image files, you will want to use Expression Media's Metadata 

Template option. Metadata templates save sets of terms so you can apply them to your digital images. You might 

want a template that includes your copyright and contact information, and/or the geographic information for 

frequently visited locations.  

Metadata templates for Expression Media are in the XMP file format. This means you can also use templates 

created for Adobe Creative Suite products. If you have a recent version of Photoshop installed, templates created 

for it or any other CS application should automatically show up in the menu below your Expression Media 

metadata templates.  

Metadata templates allow you to add prepared information to digital images with just a few clicks. You can use 

the AutoFill option to update (append to) existing fields or to add completely new information. Since Metadata 

Templates are specific to your user profile and not to the existing catalog, you can access your templates from 

any catalog and apply them to any set of cataloged images.  

CREATING A METADATA TEMPLATE  

 

It takes no more time to create a metadata template than it does to annotate a single image file without a 

template. Once you create a template, you can apply the same information to any number of images. You can 

even apply a metadata template to a set of images on import directly from your camera or memory card to 

Expression Media.  

1. Select any image and click the Annotate/AutoFill button under the Info panel. 
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2. Select Create Metadata Template from the list. 

3. You'll see a list of annotations you can modify within the Create Metadata Template dialogue.  

  

Initially, the Create Metadata Template dialogue will be empty. After filling in the fields you want to use, give the template a 

memorable name and click the OK (or Save) button to add this template to a list that appears when you select the Autofill 

button. 
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Add text to the fields you want to apply in the future. Since information is not immediately written to the original 

image with Expression Media, you don’t really save time by applying all the information in a single pass. As you 

create templates to apply when appropriate, it's possible to layer them, applying one after the other, until you have 

added everything you need. For example, you could first add your creator, copyright and contact info, and then 

add another template that input locations where you frequently make pictures. 

4. The last step is to save the template.  

Windows users: Give your template a meaningful name, such as “Copyright-Contact-[yourname]” and click the 

OK button to save the template.  

Mac users: Click the Save button, enter a template name in the Save As dialogue that appears and click OK.  

 

You can also use any annotated image to create a metadata template. Select the image you want to use as a 

template and then choose the Save Metadata Template from this same menu. In the Autofill menu at the top of 

the Info panel (the pencil icon), select the Save Metadata Template option. In the dialogue box, give the template 

a name. Expression Media will save the metadata template as an XMP file for future use.  

APPLYING METADATA TEMPLATES  

1. First, select the images you wish to populate with metadata. 

2. Click the Autofill (pencil icon) button in the upper right of the Info panel and select the template you created in 

the steps above.  
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You can access existing Metadata Templates for Expression Media under the tiny pencil icon to the right of the image file 

name in the Info panel view. Select a template, release the mouse button and the values in that template add to the catalog 

entry for that image. 

 

The Autofill icon can be a little difficult to locate the first time you use it. Shown above is the Mac version of Expression Media. 

4. The resulting Apply Metadata Template dialogue will show annotations included in your template. If you don’t 

want to apply one of the annotations, clear the green check mark beside the field you want to exclude. Note 

there are additional options at the bottom of this dialogue that further control how the template is applied. 

 

When you apply a Metadata Template, be sure to uncheck Fill empty fields only if you want to replace 

values. The resulting dialogue will show annotations included in your template. If you don’t want to apply one 

of the annotations, clear the green check mark to the left of the field you want to exclude. 
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When you apply a Metadata Template, uncheck Fill empty fields only if you want to replace the values in fields. Shown 

here is the Windows version of Expression Media. 

 

After you apply a metadata template or fill in a metadata field, you will see the small, clear bar beside the field name's turn 

green. This indicates the value has been entered but not confirmed or written to the database. 

4. After selecting your options, click the OK button and you’ve successfully applied a metadata template! You can 

also click on another image or area outside your current selection to apply the metadata. 

5. Remember, however, that applying a metadata template only adds the information to the Expression Media 

catalog. Before sending files to a client or other image user, be sure to Sync Annotations so this information is 

written to the original file. 
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You can also apply a metadata template when using Expression Media's Import from Camera option. Specify 

which Metadata Template to use under the Options tab of the Import from Disc/Camera dialogue. To access 

the advanced options for that template, click on the document icon to the right of the selected template name.  

 

Click on the document icon to modify the selected metadata template before importing images from your camera or memory 

card. 

Import can also use metadata templates created by Expression Media in other applications, such as Adobe 

Bridge and Camera Bits Photo Mechanic. Likewise, Expression Media can use any metadata templates you 

created and stored for Adobe Creative Suite applications or Photo Mechanic. The metadata templates for 

Expression Media are stored in the locations indicated below. 
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If you do not find a folder labeled Metadata Templates at the location specified below, you can create that folder 

if you want to copy in templates from other programs. 

Note for Mac users: Expression Media doesn't include the ".xmp" extension in the file names of templates it 

saves.  

Windows XP: 

C:\Documents and Settings\<user_name>\Application Data\Expression Media\Plug-ins\Metadata Templates  

Windows Vista: 

C:\Users\<user_name>\AppData\Roaming\Expression Media 2\Plug-ins\Metadata Templates  

Windows XP: 

C:\Documents and Settings\<user>\Application Data\Expression Media 2\Plug-ins\Metadata Template  

Macintosh:  

Macintosh HD/Users/<user_name>/Library/Application Support/Expression Media 2/Plug-ins/Metadata Templates  

In order to apply these metadata templates Adobe Creative Suite applications you will need to copy XMP 

templates created by Expression Media from the locations above and place them where your other Adobe and/or 

Photo Mechanic metadata templates are stored. See the following page for a list of those locations. [link to 

separate page that notes the location of the metadata templates for Adobe products] 

Adobe applications store metadata templates here... 

Mac: [user]:Library:Application Support:Adobe:XMP:Metadata Templates 

Windows: C:\Documents and Settings\[user]\Application Data\Adobe\XMP\Metadata Templates 

Windows Vista 

IN SUMMARY:  

Expression Media is a very flexible tool for cataloging images on an internal or external hard drive, server or 

removeable media. It can display a wide variety of image file types, read and write both major forms of photo 

metadata to these digital images. It stores information within its own database and offers the option to write this 

information back to the original file. 

 

 

 

 

 

 


